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Hi and Welcome to 'How to Podcast' 
This guide aims to get you started on the road to becoming a podcasting expert. My 
name is Colin Gray and I have taught podcasting in various forms for a few years now, 
most recently at University level in Edinburgh. I have also created quite a few podcasts 
over the years, mostly around education, so I’ll be using all that experience to help you 
get started on your own podcasting journey. 

I also run the website 'The Podcast Host' at http://www.thepodcasthost.com. This 
website offers quality, well supported podcast hosting. If you'd like to get some space on 
the site, go to the sign up page and find out how.  

In this guide I’ll take you from a complete beginners level, right up to publishing your 
first ever podcast episode. If I’ve achieved my aim, by the end of this guide you’ll be a 
confident podcaster and happy to go forth to create your own podcasting series.  

Whatever your context is, I'm sure podcasts will be a great medium for getting the word 
out. And, on top of it all, it's great fun. 

So, why wait – let’s get started! 

 

 

Colin @ The Podcast Host 

 

http://www.thepodcasthost.com/
http://www.thepodcasthost.com/create-podcasting-site-podcast-host/
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What is a Podcast? 
A podcast is really just a series of audio or video recordings. 

For example, BBC Radio 1 have a Podcast called ‘The Best of Chris Moyles’. This 
podcast is a series of audio recordings from Chris Moyles’ radio show, broadcasting the 
highlights of the show every few days. 

A podcast episode is one audio or video file from that series, much the same as TV 
programmes have episodes which are one part of the whole series. The word ‘podcast’ 
refers to a series of audio or video files, while a ‘podcast episode’ is one audio file from 
that series. 

What Kind of Media can Make up a Podcast? 
As you’ve picked up by now, podcasts can be either audio or video. Most commonly 
they’re in an audio format, simply because that’s the easiest way to record them, and it 
makes them easy to use as you can listen to them on the go on your MP3 player. Some 
people record a series of videos though, more like a TV series, and release it as a 
podcast. 

What form does a podcast usually take? 
Podcasts, when you listen to them, are mostly very similar to radio shows. Each 
podcast will have a particular theme – e.g. mountain biking or knitting – and each 
podcast episode will talk about a particular subject in that theme – e.g. how to knit a 
scarf or how to jump your bike.  You’ll normally have either one presenter, or a few, 
talking about that subject, and sometimes you’ll hear interviews with guests. 

Many podcasts are really simple – just a few friends chatting about a subject – and 
they’re great and really easy to make. Some of the more professional podcasts are 
produced like radio and TV shows though. They can include theme music at the start, 
background music during the podcasts and little sound effects between interviews or 
sections. They sound great, but they take a lot longer to produce. 

What’s the Difference Between an Audio File and a Podcast Episode? 

One of the things people find most confusing about podcasts is how they differ from 
normal audio or video files. Well, this is both pretty simple and a bit complicated at the 
same time. 
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The simple answer is that a podcast episode is just an audio file which you can 
subscribe to. This is done through a technology called RSS (the complicated bit…) but, 
the good thing is, you don’t need to worry too much about the feed itself, it’s handled for 
you if you use a podcast hosting website. I’ll explain a bit more about RSS feeds in the 
‘Using a Podcasts as a Listener’ section. 

It basically means that you have a list of podcasts that you have subscribed to, and new 
episodes of those podcasts automatically appear on your computer when they’re 
released. With normal audio files you would have to search them out on the web and 
download them yourself, but RSS feeds allow all of that to be done for you. 

The main thing to remember is, an audio file on its own is just an audio file. 

But, an audio file which is uploaded to a website and included in an RSS feed so that 
people can subscribe to it – that’s a podcast! 
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Using Podcasts as a Listener 

What do I need to listen to a podcast? 
There are a few different ways that you can listen to a podcast, and some of them 
depend on how the podcast makers are publishing their podcast. Some don’t require 

any more equipment than a PC or a Mac, 
and some require a bit of extra equipment 
and software. 

Let’s look at the options. 

Listening to Podcasts on your 
Computer 
The simplest way to listen to a podcast is 
just to navigate your way to the website on 
which it’s hosted, find the episode you 
want to listen to, and hit the play button. 

That’s it! 

All you need for this method is a PC or a Mac and an internet connection. 

Most podcast websites will allow you to play the podcast episodes directly on the web 
page. But, obviously that means you’re tied down to your PC which isn’t very flexible. 

Listening to Podcasts on the Move 
Often the best way to listen to a podcast is to load it onto an MP3 player of some sort so 
that you can play it while you’re out and about. This means downloading the podcast 
from the website somehow. We’ve talked about subscription, but I’ll get to that in a bit, 
because the simplest way is to just to download the podcast directly from the webpage 
mentioned above. 

Normally the page that allows you to play the podcast will also allow you to download it. 
So, you can download the podcast to your computer, transfer it to your player, whether 
it’s a MP3 player, an iPod or your mobile phone, and listen to it straight away. 

For this method you need a computer, an internet connection and a digital mp3 
player (mobile phone, iPod, etc) 
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Automating your Podcast Listening 
Of course, the most powerful way to listen to a podcast is to use all the powers of the 
RSS feed, automating the whole process. This takes a bit more setting up and requires 
extra software, but if you listen to a lot of podcasts, and particularly if you want to keep 
up with the whole series, then it’s the best way in the long run.  

Sometimes, of course, you won't need to go this far and it’s easiest just to download 
one here or there, but it’s worth covering. 

How do I subscribe to a podcast? 
To subscribe to a Podcast you need special software called a pod catcher. Examples of 
these are iTunes or Juice, but there’s a range of options out there. Many music players 
have added pod catching capabilities to their range of options, Winamp being a good 
example. Most of these options are free so you don’t have to pay a penny to get 
podcasting. 

Let’s take iTunes as an example of a pod catcher as it’s one of the most powerful 
thanks to its great podcast directory, included in the iTunes store. You simply go to the 
iTunes store, and type the subject you’re searching for into the search box. For 
example, I’m going to search for a Web Design podcast to keep up to date with my 
work. 

The process is: 

1. I navigate to the Podcast section of the iTunes store, then type ‘web design’ into 
the search box. 

2. Once I’ve done this iTunes will bring up all podcasts that include that phrase in 
the title or description. 

3. I see one called The Boagworld Show, and click on that title or icon. 
4. ITunes shows me the list of episodes in that Podcast series and I can browse 

through. 
5. If I like what I see, I press the Subscribe button, and that podcast is added to my 

subscribe list.  
6. I go back to the search results and do the same with ‘Think Vitamin’ and ‘The 

Sitepoint Podcast’. 
7. Then, upon clicking the Podcast section in the iTunes menu I see these three 

podcasts in my subscribe list. 

Now, whenever I have iTunes running, it’ll regularly check for new episodes of each of 
these podcasts. When I plug in my iPod, iTunes will delete old episodes that I have 
already listened to and send new episodes to my iPod, all ready for listening to when 
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I’m next out. I never need to check for new episodes again – the newest episodes will 
always be available to me on my player. 

For this method you need a computer, an internet connection, a digital mp3 player and 
a pod catcher application 

Manually Subscribing to a Podcast 
That was the process with iTunes, but it’s similar with other pod catchers. Most don’t 
have as good a directory as iTunes, and sometimes you need to manually add a 
podcast to the player. This is accomplished by copying the web address (or URL) of the 
podcast RSS feed and pasting it into the pod catcher. All pod catchers will have a pretty 
prominent option to ‘Add a Podcast.’ Upon selecting that it will ask for the RSS feed 
address. 

You can normally find a podcast’s RSS feed address by looking at the 
website and following links to ‘Subscribe’. It’s often very well 
advertised. Other times you should look for the RSS icon, which is 
shown here. Upon clicking that you are normally taken to the RSS feed 
page. You can just copy the address of that page from the address bar 
in the browser and put it into your pod catcher.  
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What Equipment Do I Need to Create a 
Podcast? 
You’ll be pleased to find out that creating your own podcast is amazingly easy, and 
requires very little equipment. Even better, the equipment you do require is often 
already available to you. 

In this section I’ll go through exactly what you need to create your own podcast and 
were you could go about finding it. 

Digital Recording Devices for Podcasting 
The most basic thing you need for any podcast is a recording device. Naturally, to 
create an audio file, you need to be able to record your voice! 

Recording devices take many forms, from really simple 
Dictaphones to full-quality professional audio recorders. Plus, 
your computer can act as a recording device – it’s easily possible 
to record a regular podcast using no more than a laptop and its 
inbuilt microphone. 

For good results, it’s normally desirable to have at least a simple 
mobile recording device. Without a recorder that you can carry 
around, you’ll be stuck to your computer desk for all your podcast 
creation and, especially with a group, that’s often not ideal. 

It’s worth spending more than the minimum on a recording device as the quality is very 
dependent on price. Moving above the £50+ mark generally takes you into the range of 
good quality recorders, and you can spend infinitely more than that it you try.  

For my lower cost device, I use a Sony IC Recorder 
(ICD-UX71) – shown above. This costs around £60 to 
£70 and gives a great quality sound for the price. It has 
a USB port on the bottom so you can plug it straight 
into your computer, and it has an external microphone 
socket so you can always plug a better quality mic in at 
a later date if you decide you need the sound quality 
improved. 

For a higher end device – better quality sound and 
more recording options, you could look at the Roland 
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R-05. It’s about twice the price of the Sony, and I find it a great little recorder. The sound 
quality is definitely better than the Sony, although only noticeable when you compare 
them side by side and it just offers a few more options when you’re doing your 
recordings. 

The Roland comes in around £140 on Amazon and would do perfectly for anyone up to 
professional journalist level.  

Using your Mobile Phone for Podcasting 
If, however, you don’t fancy spending any money on podcasting, you could look at the 
equipment you already have. Mobile phones are great recording devices, and it makes 
sense considering they’re built purely for recording and transmitting your voice. 

Pretty much any smart phone will have a voice recording capability, and devices like the 
iPhone or Galaxy S2 have great recording and editing facilities. They also let you email 
the file to yourself straight away so you always have a backup in case you lose the 
device. 

Even if you don’t have a smart phone, many older phones can still act as a Dictaphone. 
Have a browse through your phone menu and you might find an audio recording or 
Dictaphone function that you never knew you had. 

Microphones 
One great addition to your podcasting kit list, if you have the 
money, is an external microphone. Even a low-cost 
microphone can often increase the ease and quality of your 
recordings. 

Both of the recorders above can take external mics and will 
benefit from using one. Plus, if you’re recording from a 
computer, you’ll almost certainly need an external 
microphone. The microphones built into laptop PCs are 

normally very low quality and aren’t worth using 

For computer recording, you have a huge range of options. A standard headset 
microphone – the type you would use with Skype - will do the job quite well. Canyon 
headsets, available for around £15 on Amazon, create a good quality recording, but for 
really good sound quality you could go for the Samson Go Mic as shown above. 
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For use with your digital recorder, you might want 
to get a more traditional looking microphone. The 
audio technical ATR 6250 is a reasonably low-cost 
mic which plugs into any recorder with a small mic 
jack (same as your headphone socket) and if you 
spend much above that you’re usually guaranteed 
a good quality as long as it’s from a good brand. 

Microphones are actually surprisingly technical bits 
of kit and there are all sorts of variations and 
configurations, but you can get a good one for less 
than £50 so don’t worry too much about the higher 
end ones. Often it’s more about your environment than the microphone when it comes 
to final recording quality, as we’ll discuss in the recording chapter. 

Podcasting Software 
In ideal circumstances, you can actually create a podcast without any software at all. 
You could make a recording and upload it to your podcasting hosting space straight 
away, with no editing. This depends on you being pretty accurate with your recording of 
course, and making no slips or mistakes! 

In reality, people make mistakes and you often need to make edits to an audio file 
before you publish it. You may also want to add music or sound effects to a podcast, or 
to stitch two separate audio files together, such as your introduction and an interview 
you did at another time. 

In this case, you need audio editing software. The good thing is, it’s an easy choice. 

If you don’t already have an audio editing package, then Audacity is the package for 
you. It’s powerful, it does everything you need, and, best of all, it’s free! 

You can download a copy of audacity at: http://audacity.sourceforge.net/ 

We’ll look at how to use audacity to edit your podcast in the editing section. 

So, that’s all we need to get started – on to recording! 

http://audacity.sourceforge.net/
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Recording Your Podcast 
It’s time to grab a glass of water, warm up that voice and get recording! In this section 
we’ll look at how to go about recording your podcast, including scripting and how to set 
up your recording space. 

To Script or not to Script? 
This is the question asked by every would-be podcaster, and one of the most debated 
areas of podcasting prep. Should you write a full script? 

Fortunately, the answer is easy, if not very helpful – it depends on what you’re 
comfortable with! 

I know a number of podcasters that hardly write anything down. They know their subject 
back to front and they just go into the recording with a broad outline of what they’ll talk 
about. They might have 4 or 5 bullet points, and they come across great on air – smooth 
and friendly. The spontaneous and unplanned nature of this approach makes the 
podcast sound really personal and engaging, and, if done well, it can sound great. Also, 
it takes very little prep. You can create a podcast very quickly using this method. 

The downside of this approach is that, without a script, expert or not, you’ll often 
stumble over your words, run out of things to say, or simply forget to cover everything 
you planned to. It’s very hard to do a 20 minute podcast with just a very broad outline.  

Alternatively, I also know podcasters that write everything down, word for word, even 
having done it for years. They’ll have a full script and read it out slowly and surely, 
sounding very articulate and expert. Everything will be perfect, no points missed, and 
the podcast will go exactly as you plan. 

The downside of this is that it takes a long time to prepare. You’re carrying out two tasks 
– writing an essay on your subject, and then speaking it out. Added to that, when 
reading a script, you can often sound pretty un-spontaneous, flat and even robotic. It 
can be less engaging than off-the-cuff speech and definitely less friendly. 

In reality, a blend is often best. 

You can write a script with is bullet pointed, but with a fair bit of detail. Don’t write it 
down word for word, but have a prompt for each paragraph so that you know where 
you’re going. This way you won't miss anything, but you’ll hopefully avoid the monotone 
reading-voice problem. 
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Your Environment 
Even though we’ve talked about the quality offered by recording equipment, 
microphones and software, one of the biggest factors in how your recording will sound 
is your environment. Thinking about where you do your recordings is really important for 
good quality sound. 

Here are a few things to think about when choosing where to do your recording: 

• Background noise is far more obvious on a recording. Watch out for: 
o Corridors with people walking by often 
o Windows close by with a busy road outside 
o Computers or other equipment running in the background 
o Large lights making a buzzing sound 

• Echoes can really reduce the quality of your recording: 
o Try to record in a large room, not facing the wall 
o Or try to record in a room with soft walls – wood or wallpaper 

Here are a few things to think about when doing your recording: 

• The presenters themselves are often the biggest cause of noise: 
o Rustling of paper or jangling of keys by presenters or guests 
o Coughing, sniffing and heavy breathing 
o Fumbling the microphone, or moving the recorder 

The main thing is to be aware that any noise is very easily picked up by the microphone. 
You want the room you choose to be as quiet as possible, and you want the others in 
the room to be as careful as they can not to make unnecessary noise. 
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Editing Your Podcast 
One you’ve done your recording, it’s time to turn it into an edited podcast. This is where 
you take out any mistakes, stick together different audio recordings and add any music 
or sound effects.  

Music and Sound Effects 
Music can make a big difference to how professional and engaging your podcast 
sounds. A short 10 second musical intro can really make your podcast stand out from 
the crowd, and that audio can be used at different points as background music to make 
it sound even more professional. Sounds effects too can really enhance your podcast, 
offering a little buffer between one audio recording and the next - your introduction and 
an interview, for example. 

There are a number of places to locate royalty free music on the web. Most of them 
require you to simply credit the creator of the music on your website or on the podcast, 
and then you can use the music as much as you like for free. 

Have a look at these sites for some good choices: 

• http://incompetech.com/m/c/royalty-free/  
A good site for royalty free music. All tunes are available for free use as long as 
you credit the creator. 

• http://www.jamendo.com/  
This site has thousands of albums worth of music free to use for various 
purposes as long as you credit the creator. It's mostly under creative commons 
licensing. 

• http://www.partnersinrhyme.com/pir/free_music_loops.shtml  
Has some good music loops and a number of sound effects. 

• http://www.sounddogs.com/  
Great for simple sound effects for any video project. 

Editing in Audacity 
Audacity is a really simple audio editor to use, but it does take a short time to figure out 
the tools. The creators of Audacity have created a great set of documentation which you 
can access here:  

http://audacity.sourceforge.net/manual-1.2/ 

http://incompetech.com/m/c/royalty-free/
http://www.jamendo.com/
http://www.partnersinrhyme.com/pir/free_music_loops.shtml
http://www.sounddogs.com/
http://audacity.sourceforge.net/manual-1.2/
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I have put together a short set of instructions below, based on that material, to get you 
started. This is what you’ll need for your first few podcasts and covers the basic editing 
tasks. 

Import an audio file 
There are three ways to do this:  

1. Simply drag and drop the audio file in to the Audacity window. (If you're using Mac 
OS 9 or X, drag the audio file to the Audacity icon instead...)  

2. Select Import Audio ... in the Project menu.  

3. Use the keyboard shortcut: CTRL+I  

Audacity can import WAV, AIFF, AU, IRCAM, MP3 and OGG files. Please refer to the 
file formats page for further reference on these audio formats.  

4. Playback 

The imported file should now be displayed in an audio track. The track will look a little 
like this, depending on what you imported:  

 
Trackpanel and Waveform Overview of the imported Track 

If you're not sure where to find audio material, simply rip some off a CD, or in Windows, 
check the Media folder in the directory of your Windows installation.  

Now click on the green Play button at the top and you should hear the file you 
have just imported.  

  

http://audacity.sourceforge.net/manual-1.2/fileformats.html
http://audacity.sourceforge.net/manual-1.2/toolbar.html
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Selecting, Cutting and Pasting 
The most basic editing task is to cut and 
paste. People did this with tape and it's 
every easier with data in your computer, 
so take a look at these basic operations, 
referred to as Cut, Copy and Paste.  

It is assumed that you have a project open 
and that at least one track of audio 
material is present. 

Let's take a look at this example of an 
Audacity window. Let's say we want to cut 
out a section in the middle of the audio file 
shown. First we've got to select it. 

Making a selection 

To select the part you wish to cut, copy or paste to, use the selection tool . If it's not 
activated, do so now by clicking on it in the toolbar. 

Now press and hold the left mouse button while you drag the mouse to mark an area. 

This area is darker than the surrounding area of the clip. Note that even though you can 
mark an area larger than or extending beyond the actual audio clip in the track, the 
operations will only work on the actual clip. Playback however will work outside the clip. 

Press the space bar to listen to the audio in the marked area.  

To extend or contract your 
selection, hold down the SHIFT 
button and click on the area you 
wish your selection to extend or 
contract to. 

If you click at a spot that is on 
the right hand side from the 
middle of the current selection, 
you will set the right hand 
boundary of your new selection. 

  

http://audacity.sourceforge.net/manual-1.2/toolbar.html
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Cutting the selection 

Cut the selection by selecting "Cut" from the Edit menu ... or press CTRL+X. 

Before the cut After the cut 

        

To undo this operation, select Undo in the Edit menu or press CTRL+Z 

Copy will copy the selection to the clipboard. 

You can then paste that data back in to any track by clicking where you want this audio 
to be inserted and select Paste in the Edit menu, or press CTRL+V. 

Thus pasting is the opposite of cutting. You can also copy material, make another 
selection with the mouse and then paste. This will replace the selected material with the 
contents of the clipboard, no matter how short or long either of them are. 

Mixing background music with a voiceover 

Audacity makes it very easy to mix two different sounds together. 

• Open one sound (for example, the background music).  

• Select Import Audio... from the Project menu and open the other sound (for 
example, the voiceover).  

• Listen to your sound using the Play button. Audacity automatically mixes them 
together. 

• Choose the Time Shift tool  and adjust the position of one track or the other 
by dragging them left or right. Move them until they're synchronized the way you 
want them. You can even move tracks around while they're playing. 

• If you hear clipping which wasn't present in either of the original files, it means 
that the combined volume of the two tracks is too loud. Use the gain controls on 
the tracks to reduce the volumes until you don't hear clipping anymore. 

• Export as a WAV or MP3 file. 

http://audacity.sourceforge.net/manual-1.2/menu_edit.html#cut
http://audacity.sourceforge.net/manual-1.2/menu_edit.html#cut
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Exporting your Finished Podcast 

Once you’ve done all of your editing, it’s time to export the finished article! 

To export your podcast click on File > Export. This will allow you to choose where to 
save the file. The important thing here is to make sure you choose the MP3 format. This 
is the most commonly used format for podcasting, and is the one that every digital 
player will be able to process.  
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Publishing My Podcast 
Once you’ve recorded your podcast, edited it up and saved it as an MP3, it’s time to 
publish it to a Podcast hosting site so that your willing public can listen to your efforts. 

Podcast Hosting 
In order to store your podcast episodes and deliver them through an RSS feed, you 
need a special podcast hosting space. This allows you to upload your podcast 
episodes, put a little intro text alongside them and then publish them for all to hear. 
Once published, the podcast hosting site will organise the RSS feed and make sure 
anyone can subscribe to your podcast if they so choose. 

There are a few options for Podcast Hosting sites, but I'm going to talk about my own 
service, as I genuinely believe it's one of the best out there. I help to run The Podcast 
Host - www.thepodcasthost.com. The Podcast Host prides itself on up-to-date features, 
quality plugins and superb support. The system uses the most up to date version of 
Wordpress to host your podcasts, unlike many other podcast hosting solutions which 
are stuck on old versions. 

Obviously it's up to you who you go with though, but I'd appreciate it if you keep us in 
mind. Whichever you choose, you’ll be asked to create an account, after which you’ll 
have a site set up for you. 

Posting your podcast 
Once your podcasting space is set up, it’s time to post a podcast to that space. 
Podcasting works in a similar way to blogging. You create a page, commonly called a 
post, which contains some text and a link to your podcast.  

The text is quite important as it forms a guide to the podcast episode, and entices 
people in to listen to it. Here are some good things to include on a podcast episode 
page:  

• Write an introduction to the podcast, offering a brief summary of the subject 
• Include a time schedule of the show, showing when each section starts so that 

the listener can quickly fast forward through if they want to hear a particular 
section 

• Include a request for feedback, either through comments or email. 

Once you’ve written your post, it’s time to upload the audio file itself.  

http://www.thepodcasthost.com/
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On The Podcast Host the process is very simple. Once you've logged into your account, 
click Post on the left hand menu, and then 'Add New'. You'll see a screen similar to the 
one below.  

First, write your title and post text. This should give your listeners a good idea of what 
the podcast is about. Next, click the ‘Upload Audio’ icon, as shown. 

 

This will bring up a dialogue box to let you select the audio file on your own computer. 
Once you have uploaded the file, you can give it a title, and insert it into your post using 
the button shown below. The title is quite important as it determines the text that will 
appear as a link to your podcast, although you do have the option to make this text not 
appear at all. In it's place you can have a play button instead. 

The Podcast Host offers a lot of flexibility over where your podcast link appears, 
whether that might be a small play button within a paragraph, or a large audio player at 
the start or end of the page. 

Once you've decided all of that, click Publish to finish the process. 

You now have a live podcast! 
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That's all folks! 
I hope this guide has given you a good introduction to the world of podcasting. It should 
have provided you with enough information to create your very first podcast, and go 
beyond the simplest form by editing and introducing music and effects. 

If you have any further queries about podcasting, or would like to sign up for some 
podcasting space, you can get in touch with me at  

http://www.thepodcasthost.com/contact-us 

I'd love to hear what you come up with in future so do send over a link to any podcasts 
you create - I'd be happy to feed back on them and offer advice. 

Good luck with your podcasting efforts, and I'm sure I'll hear you out there! 
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